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Software Introduction 
 

Cube-a is a GNSS surveying and mapping software which is developed by the Stonex srl company. Based on years 

of accumulating market experience, in combination with the international mainstream of surveying and mapping 

data acquisition function of the software, integrating RTK control, GIS data collection and road design and layout 

into one role. The main feature of the software is very outstanding graphic interaction, very powerful function and 

humanizes operation process. This manual mainly introduces all the menu functions and the field operation 

procedure of the Cube-a software. 

The main interface window is divided into the main menu bar and sub-menu bar. 

The main menu bar contains all the menu commands, content is divided into six parts: Project, Device, Survey, 

Configure, Calibrate and Tools. In this manual, we will introduce the functions of those menus in detail. 

 

 

1. Cube-a installation and uninstallation 
 

This chapter describes the installation and uninstallation instructions for Cube-a Software. 

1.1. Cube-a Installation 

1. Please download the Android Cube-a installation package (*.apk) and copy the installation package to your 

Android device. 

2. Please find the Cube-a installation package (*.apk) in the “Files” of the Android device. Click the Cube-a 

installation package, there will pop-up the installation page. Then click “Install” to install the Cube-a 

software, after the installation successful, there will be the prompt page as shown in Figure. 
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1.2. Cube-a First Run 

The software must be registered and unlocked at its first run. To unlock it you need to know which is your 

personal and unique Purchase Code ID. 

The Purchase Code ID is in a form like A0X000000000000 and you should have got it by e-mail or printed. The 

software cannot be unlocked without entering the correct Purchase Code. 

This operation must be done while your device (tablet or phone) has an active Internet connection. 

To register the software: 

• Launch the application as usual. 

• Carefully read the shown End User License Agreement (EULA). 

• Press the Accept button if you agree to be bound by the license agreement. 

Otherwise press the Decline button to terminate the application. 

• Fill out the Software Activation form. 

• Press OK to activate the software. 

The above steps must be followed at each time the application is started and until the software has been successfully 

activated. 

The Purchase Code, that must be entered in the first field of the form, is the proof of purchase required to identify 

and validate your software license. 

To validate your software license and the authenticity of the Purchase Code itself the program will connect to our 

servers: at that time the Purchase Code is verified and, if all goes well, the program will get back the authorization 

to activate the software. 

Notice that you cannot reuse the Purchase Code to unlock a copy of the program that has been installed onto 

another device. For that you will need to buy an additional license (thus, you will get another different Purchase 

Code). 

In case of any problems during the activation of the program please contact your local dealer or the Stonex Support.  
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1.3. Cube-a Uninstallation 

There are many ways to uninstall the software on the Android device. Here we mainly introduce two methods: 

• Press the Cube-a icon on the desktop and drag it to the “uninstall” option box, there will pop-up a dialog 

box “Uninstall Cube-a?”. Then click “uninstall” to uninstall the Cube-a software. 

• Click the “Settings”— “Apps” to find the “Cube-a” in the submenu. Click the “Cube-a”, there will enter the 

Cube-a information page. Then click the “uninstall” to enter the Cube-a uninstallation page. Click the 

“uninstall” to uninstall the Cube-a software. 

 

2. Interface 
 

2.1 Status Bar 

The status bar is visible in any submenu of the software. It changes if you are working in GPS or Total Station mode.  

If you are working on GNSS mode, the status bar looks like the screen: 

 

The bar in GNSS mode contains: 

1) Name of the current project and the. pd file in use 

2) Status bar respecting of the tolerances set in configuration 

• Green → tolerances respected 

• Red → tolerances not respected 

3) SD horizontal and vertical of the current solution of the receiver 
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4) Satellites used and see by the receiver 

5) Solution’s state 

6) Datalink mode and age of the corrections received 

7) Battery power level 

8) Switch to Total Station mode 

9) Current position 

10) Tilt angle (option available only with models with Tilt option)  

If you are working on Total Station mode, the status bar looks in the following way:  

 

It contains:  

1) Project name 

2) Total station measures: 

• HA: horizontal angle 

• VA: vertical angle, tapping on the box, vertical angles can be seen in percentage 

• SD: slope distance 

• HD: horizontal distance 

3)  Face of total station currently used: F1 is face left, F2 is face right 

4) Prism lock status:  

•  the prism is not locked 

•  the prism search is working 

•  the prism is locked 

5)  Enter the Total station control panel 

6)  Battery status 

7)  Switch to GPS mode.  

8) Current station name. Tapping on the bar, coordinates of the current station are shown.  

 

2.2 Menu Bar 

The Cube-a interface is composed also by the Menu Bar. 

The Menu bar is placed in the lower part of the screen and allow the user to select the 6 submenus of the 

software. 

Here below are mainly explained the features of the icons. 
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It contains: 

1. Project → The project menu where the user can manage his project, import/export files and share files 

2. Device → The device menu is dedicated to managing and set the device used. Users can manage and set 

their GNSS receivers and Total Stations 

3. Survey → The survey menu is the area where the user can make measures and make his job 

4. Configure → The configure menu is dedicate of the settings of software 

5. Calibrate → The calibration menu is specific for some field operations like the site calibration or the 

calibration of device’s sensors 

6. Tools → Inside Tools the user can find the COGO calculations and other useful tools 

Inside the next chapters all the main menus will be detailed explained. 
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3. Project 
 

In the main interface of the software, click the "Project": the submenu shown in figure will appear. The project 

submenu contains seven items, which are Project Manager, Project Details, File Manager, Collected Points, Import 

Data, Import Raster Image, Export Data, Feature Codes, Share by WIFI. 

 

Cube-a stores all the data in the form of a set of files called a project. Cube-a remembers which the last used project 

and it was automatically reopens that project at the next run. Under normal circumstances, each time you begin to 

measure an area, you should create project file matched with the pre-construction engineering, and the file name 

should be “*.GSW”. After the project has been created, the software will create a file in the device storage disk and 

the file name is same of the project, all data will be saved in this file. 

 

3.1 Project Manager 

Click “Project Manage” in the Project submenu: you will get to the “Current Project” page.  
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Click "New" in the left corner to create a new project.  

 

The page that create a project shown in the figure please click “ok” after entering the project name (required), 

operator name, instrument, and notes.  

The Enable GIS function, disabled by default, is available from the Cube-a v5 with the GIS module. See the chapter 

3.1.1 GIS Module for further insight. 

Then there will pop-up a prompt “Apply current coordinate system transformation parameters?”. If you select "OK", 

then the coordinate system parameters of new project are same with the current project settings. If you select 

"Cancel", you can select the coordinate system parameters manually according to the engineering survey, or you 

can apply the local parameters. Click "OK", the new project will default to the current work of the project and return 

to the software main interface. 

If you want to change the project file, please press, and hold the project in the project list. Then if you click “Open”, 

this project will be open, and it will be also the default work open at program startup. 

If you click “Delete”, this project will be deleted. 
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If you press Share you can share the project to other devices through services like Google Drive, WhatsApp etc. 

If you press “Clone” you will create a new project equal, then the project cloned. 

 

3.1.1 GIS Module 

If you have the GIS Module, you can enable the GIS option when you create a project. If you enable the GIS option, 

then Activate GIS Feature Set Repository window appears. Here you can select a feature set repository from the drop-

down menu to use it in the current project (select it and click on OK), or to edit it (select it and click on Edit), or to 

clone it (in this case you can edit the clone without modify the existing one), or to delete it. 

  

 

If you want to import a feature set repository you should copy the repository in the XML format in the following 

folder: Internal shared storage -> StonexCube -> GISFeatureSets. Then you will see the repository in the drop-down 

menu. In the same folder you can find some sample file. You can create in Cube-a a new feature set repository 

clicking on Add, then you should type the name you want. The new repository appears in the drop-down menu, 

then you should select it and click on Edit to create the repository contents, the GIS feature classes. 



 

 

          Stonex Cube-a 5.x – User Manual   10 

  

 

In the Repository description box, you can add a description for the previous selected GIS feature set repository if 

you want. 

When you create a new repository, a class appears by default, his name is “Rename Me”, so select this one and click 

on Edit to change the name and create the feature list for this class.  

Click on Add to add a new GIS feature class. Click on Delete to delete the selected class. Click on Cancel to cancel 

the changes. Click on OK to confirm the changes and back to Activate GIS Feature Set Repository window. 

If you select a class from the Repository contents box and click on Edit, Edit GIS Feature Set window appears. Here 

you can change the class name and description, select the compatible geometries, and create or change the feature 

list. 

When you create a new class, a feature appears by default, his name is “F1”, so select this one and click on Edit to 

change the name and customize the feature. 

Click on Add to add a new feature in the current class. Click on Delete to delete a feature in the current class.  
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If you select a feature from the Feature List and click on Edit, Edit GIS Feature window appears. Here you can change 

the feature name and prompt, the data type, insert a lookup list and other options. You can create a lookup list in 

Cube-a: select Given List in the drop-down menu then click on the pencil, edit value lookup list window appears.  

  

 

3.2 Project Details 

Inside the Project Details menu, the user can check the details relative the project. 

Inside this menu the user can enable the GIS option if it has not been activated during the creation of the project. 

If the option is enabled, after clicking on OK, the user can select or change the GIS feature set repository. 

There is also the possibility to add information like Operator, Device used during the survey. 
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3.3 File Manager 

If the data of a project is too large, or if you want to divide the data into two different “survey points libraries”, 

please click “data manager”, as showed in the figure. Click “New” on the upper right corner to create another file 

into which store the data: this new file will become the default file where to store new survey data. 

The new data file is part of the current project. 

If a project has multiple data files, select the data file in the data list, click "Open" to switch between different data 

files, and click "Delete" to delete the data file. 

 

 

3.4 Collected Points 

In the collected Points menu, there are all the points stored by the user during the survey. 

There is the possibility to search code per name or code and also directly from the map using the blue hand control 

in the upper right corner. 

After the selection of a point, the user can see the details of that specific point, edit some information. 

Selecting delete, the point will be deleted. 
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3.5 Import Data 

Click “Project” -> “File Import” to start the import command.  

This command allows you to import points in coordinates (either grid coordinates or geographic/geocentric 

coordinates). 

Choose the proper format from the File Format list then click the “Open Data File” button to choose the source file. 

The path of the chosen file will be shown right below the open button and, more below, a preview of the contents 

of the file will be shown.  

 

This preview allows you, if needed, to verify that the file contains compatible data. 

Click the “OK” button to proceed with the import or click the “Cancel” button to cancel. 
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The imported points will be of class “Input Point” so they will not show in the list of surveyed points (that is in the 

list shown by the “Collected Points” command). To see the points, you must open the “Points Library”: click “Tools” 

in the bottom part of the screen then select “Points Library”. 

The imported points will be shown and possibly used when you start the stake out command. 

 

3.6 Import Raster Image 

  

Click “Project” -> “Import Raster Image” to import a georeferenced raster image. A page like the one shown in 

Image 2.7-1 with appear. Click the “Open Raster Image” button to choose a raster file to load (see Image 2.7-2). 

 

The program supports raster images that have been stored into files of the following formats: 

• PNG (Portable Network Graphics) – compressed, lossless 

• JPG (Joint Photographic Experts Group) – compressed, not lossless 

• TIF (Tagged Image File Format) – usually compressed, usually lossless 

Having a raster image is not sufficient: your raster image must come with a “twin” file that stores the georeferencing 

parameters. This file is called “World File” and it must be created on a PC using a software that handles the image 

georeferentiation. In short, the following table shows which kind of World File you must store in the same folder 

that contains the raster image to import: 

Raster Format World File Format 

*.PNG *.PGW 

*.JPG *.JGW 

*.TIF *.TFW 

 

Limits 

Cube-a runs on Android and it must adhere to its limitations about memory allocation. One of such limitations is 

that any application should not allocate big blocks of memory and if an application does so then it must release 

that blocks of memory as soon as possible. 
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Taken from Android developer docs: “To allow multiple running processes, Android sets a hard limit on the heap 

size allotted for each app. The exact heap size limit varies between devices based on how much RAM the device has 

available overall. If your app has reached the heap capacity and tries to allocate more memory, the system throws 

an out of memory error”. 

All that means that you must be careful when trying to load raster images. Even if a raster image file seems to be of 

small dimensions (some megabytes) the same is not true for the image data it contains. Remember that usually 

raster image files are compressed, and that Cube-a has to decompress them before displaying them and this 

operation could need more memory than the Android OS is able to give. 

As a rule: an image of W x H pixels in size (width x height) needs an amount of free memory equal to: W x H * 3 

bytes. 

Example: a photo of 5 mega pixels (2560 x 1920) occupies, after decompression, 14745600 bytes or 14 megabytes. 

 

3.7 Export Data 

Click “Project” → “File Export”. Data file export is used to export the measurement data file into the format which 

the user makes maps. 

You can export data to the specified format or a custom format. First fill in the (new) file name, select the export 

path, the source data file (*.PD) and the file format.  

File formats include: Stakeout Report, RW5 (raw data), DXF with CAD entities, GIS data to shapefile, Cube Fly, 

Custom File customizable, .txt file, DXF only points, Google Earth™® file format (KML), GPX, Raw measurement data 

format (CSV), Pregeo DAT (Italy only), and so on. Click "Export" to export the file to the specified path. 

  

Custom file format settings 

If you select "Custom File Format" and then click "New", you can create a new export template as shown in Figure. 

Set the field delimiter, extension name, angle format, whether to write the file header, and select the custom export 

format content. Select the content you want to export, click "Add" to add to the custom format description; click 
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"Delete" to delete the contents of the custom format description one by one. Click "OK" to complete the custom 

export formatting shown as Figure. 

You can also edit and delete the templates. To filter the points, click "Options" to select the class of points to export: 

tick the type of points that you want to export. The point classes include auxiliary point, survey point, control point, 

input point, calculated point, stake out point and screen point. 

RW5 format settings: When you export in RW5 format, you will be asked to specify/enter some additional settings 

as shown in figure.  

 

You must enter the Job Name, the Date and the Time of the job. If you need to work in feet, then you can change 

the unit of the exported coordinates/heights/distances from Meter to Feet (Imperial) or US Feet (Survey). 

It is also possible to change the format of exported angles (but not for the geographic coordinates) between 

Degrees (360) and Grads/Gon (400). 

 

GIS data to Shapefile 

Select GIS data to Shapefile to export a shapefile and a dbf file with all collected GIS data. 
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The software will create a dbf, shp and shx file for each feature class and geometry type selected, as in the following 

picture. 

 

 

Pregeo DAT format settings (Italy) 

When you export in Pregeo (DAT) file format, which the official cadastral file format of Italy, you will be asked to 

specify/enter some additional settings as shown in figure. 
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Enter: 

• Survey date 

• Protocol number 

• Name of the surveyor 

• Qualification of the surveyor 

• Province (of living) of the surveyor 

• Cadastral identifier (province, city, sheet and map numbers) 

• Average elevation and easting 

• Instrumental precisions (linear and angular) 

• Type of update (of the map) 

• Notes 

The last option at the bottom of the page allows to “merge” the baselines referring to possibly multiple GNSS bases 

of reference so that they will all refer to a single (selectable) GNSS base of reference. 

This option is useful to overcome some limitations of the Pregeo program in handling surveys with multiple bases 

of reference. 

 

3.8 Feature Codes 

The Feature Code Library is the menu to manage the libraries of the codes of the points. Inside the menu is possibly 

create more than one group. To open and edit a group select and press Edit. To create a new group of code, select 

New. 
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3.9 Share by WIFI 

The project can be share also via wifi. Select Share via WIFI to open the menu of this feature. 

 

Inside the menu the user must set the user and password of the FTP server service, then set the port. When the 

settings are done you can start the share of the file selecting Start Service. 
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4. Device 
 

Click "Device" in the main interface of the software, you will see the page shown in figures below. The Device 

submenu changes if you are in GPS or Total Station modes: from both, you can switch to the other. 

The GPS mode contains the GPS Status, Datalink Status, Communication, Working Mode, Datalink Settings, 

Information, RTK Reset, Register, WiFi Mode Settings and Distance Meter commands.  

The Total station mode contains the Total Station Communication command. 

  

The following sections will describe each of the commands in the submenu. 

 

4.1. GPS 

4.1.1 GPS State 

Click “Device” -> “GPS status”, you can view the relevant information about GPS positioning. Click "detail", you 

can see the page as shown in Figure. The information includes the latitude and longitude coordinates of current 

GPS, plane coordinates, speed, heading, solution, differential mode, differential delay, satellite, PDOP, HDOP, 

HRMS, VRMS, UTC time, local time, and the distance to base. 
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Solution state: including single solution, difference solution, float solution, fixed solution. 

Single solution: it means that the receiver did not receive differential signal from the base, the accuracy is 

lowest. 

Difference solution: it means that the receiver can receive differential signal from the base, but the data 

accuracy is low for various reasons, such as: mobile station location is too poor, too few satellites, and so on. 

Float solution: it means that the receiver can receive differential signal from the base, it is the initial solution 

obtained by the carrier phase difference data solving, the accuracy is high, generally within 0.5 meters. 

Fixed solution: It means that the receiver can receive differential signal from the base, it is the final solution 

obtained by the carrier phase difference data solving, with the highest accuracy, usually within 2 cm. With high-

precision GPS measurement, it needs to achieve a fixed solution state to record data. 

Differential mode: including CMR, RTCM and so on. 

CMR: A type of differential message formats defined by Trimble. 

RTCM: General differential transfer message format, including RTCM2.X, RTCM32 and so on. 

Differential delay: it indicates the time at which a rover receives differentials (for example, a differential delay 

of 10 seconds indicates that the rover receives a differential signal from the base station sending before 10 

seconds), the unit is seconds. When the RTK is working, the differential delay is smaller, the result is better, 

generally require less than 10 seconds, preferably 1 second or 2 seconds. 

PDOP: Position dilution of precision. When it is less than 3, it is in the ideal state. The smaller the PDOP value is, 

the better the satellites distribute, it is helpful to reach the fixed solution state. 

HDOP: Horizontal dilution of precision, which represents the component of PDOP in the horizontal direction. 

VDOP: Vertical dilution of precision, which represents the component of VDOP in the vertical direction. 
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Base positioning information contains base ID, latitude and longitude, altitude, north coordinate, east 

coordinate, height, distance to the base, shown as Figure. 

 

Satellite map indicates that the position of the satellites which receiver tracks, and it contains the azimuth angle 

and the height angle. The value on the circle represents the azimuth angle, and the value on the radius of the 

circle represents the height angle, shown as Figure below (Blue for GPS, red for GLONASS, light green for 

BEIDOU, red for Glonass, magenta for Galileo, dark green for SBAS) 

 

 

The satellite table contains the signal-to-noise ratio, the azimuth angle and the height angle of the six carrier signals 

of L1, L2, L5 in the GPS signal and B1, B2, B3 in Beidou signal, shown as in next Figure. 



 

 

          Stonex Cube-a 5.x – User Manual   23 

 

Ephemeris is a histogram represents the signal to noise ratio of L1, L2, L5 three carrier signals, shown as next Figure. 

 

 

4.1.2 Data Link Status 

Click “Device”-> “Data Link Status”, you can view the configuration and status of data link about the current 

receiver. When the data link is network, the data link status is shown in next Figure.  

There are four buttons (connect, disconnect, restart and refresh) in the bottom of the screen. Connect: click it to 

connect the data link. Disconnect: click it to disconnect the data link; Restart: click to re-initialize the network 

module; Refresh: click it to show the current data link status. 

When the data link is internal radio, the data link status is shown in Figures. You can use the “restart” and 

“Refresh” buttons. 
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4.1.3 Communication 

Click “Device” -> “Communication”, there will be the page shown in Figure. Communication settings are mainly 

used to select the communication mode between receiver and Cube-a software. Communication settings need 

to be done in the two steps: Firstly, select the Device type from the options of RTK, M series and internal GPS. 

Secondly, set the communication mode, communication mode includes Bluetooth and WIFI. In the case of 

internal GPS opening, it can read its own GPS signal to achieve positioning. 

1. Bluetooth connection 

Select "Bluetooth" communication mode in the communication settings interface, and then click "Search", you 

will see the page shown in Figure 3.3-2. If you already have a Bluetooth device in the list that you want to connect 

to, you can click "Stop" to stop searching, and select the name of the Bluetooth device to connect to the Device, 

click "Connect". When the Matching dialog box appears, please click “pair” and it could be connected 

successfully. 

2. WIFI connection 

Select "WIFI" communication mode in the communication settings interface, then click "search" to find the WIFI 

names of corresponding receivers (the default WIFI name is the receiver number), at last click the WIFI name to 

connect it. After the connection is successful, return to the communication settings interface, and click "Connect" 

to complete the WIFI communication connection, shown in Figure 3.3-3. 



 

 

          Stonex Cube-a 5.x – User Manual   25 

  

 

3. Demo Mode 

When you select the communication mode as “Demo”, then click “Connect” to enter the demo mode. You can try 

and view each function and don’t need to connect the receiver. 

 

4.1.4 Working mode 

The working mode menu is mainly used to set the working mode of the receiver, click “Device” -> “working 

mode” to enter the working mode selection interface shown as next Figure. In the working mode interface, there 

are five options including communication settings, static mode, base mode, rover mode, and Preset 

configurations. 
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When doing static measurements, please set the working mode as static. When doing RTK measurements, please 

set the working mode as base or rover. 

After connecting the Device and Cube-a software through communication settings, you can set the working 

mode, data link in the Cube-a software. The following sections describe the detailed settings in the working 

mode menu. 

 

4.1.4.1. Communication 

Click “Device” -> “Working Mode” -> “Communication”, you will enter the communication settings page same 

as the page in section 4.1.3. For the detailed description, please refer to Communication. 

 

4.1.4.2. Static Mode 

Click “Device” -> “Working Mode” -> “Static”, you will see the interface shown as next Figure. The static setting 

contains three aspects: parameter settings, antenna parameters and satellite system. The following describes the 

various parameter settings in detail. 
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Name: The name of static data is limited to 4 digits. 

PDOP limit: The geometric strength factor of the satellite distribution. The smaller the PDOP value is, the better 

the satellite distribution is. PDOP value less than 3 is the ideal state. 

Cut-off angle: The angle between the connection between the satellite and the receiver and the horizon. The 

receiver does not receive satellite signals smaller than the cut-off angle. Value range: 0-45°. 

Collection Interval: 1HZ said that the acquisition of a data per second, 5HZ said that the acquisition of five data 

per second, 5 seconds that five seconds to collect a data, and so on. 

Auto record static data: If you select "Yes", receiver will start recording automatically when it is powered on and 

receiving satellites signal; If you select "No", you need to start recording static data manually after receiver is 

powered on. 

Antenna height: Usually defined as vertical distance from the phase center of the antenna to the measurement 

point, because it cannot be directly measured, it is generally measured by other ways to calculate. 

Satellites system: satellites system settings include five satellites systems, namely "GPS", "GLONASS", "BeiDou", 

“Galileo” and "SBAS" system. According to the needs of measurement work, you can choose whether to receive 

the corresponding satellites signal. (Note: only if the receiver supports the Galileo constellation then Cube-a will 

Galileo satellites in this page.) 

SBAS: Wide-area differential augmentation system (satellite-based augmentation system). The navigation 

satellites are detected by a large number of widely distributed differential stations and the acquired raw data is 

sent to the console. And then by the console through the calculation of the various satellite positioning 

correction information, and through the uplink injection station sent to the GEO satellites. Finally, GEO satellites 

will send the corrections to users, help to improve the positioning accuracy. 

In the static mode settings, after all parameters have been set, please click "Save to Configurations" to store the 

static parameters. As shown in next Figure, the static parameters of the current mode could be saved to the file, 
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so that you can recall the configurations next time when you need. The configuration name could be set by 

users. 

After the parameters in the static mode settings are set, click "Apply" to change the working mode of the receiver 

to static mode. 

  

 

4.1.4.3. Base Mode 

Click “Device – Working Mode - Base” to enter the “Base mode settings” page shown as next figure.  The base 

mode settings contain four aspects: startup mode, option settings, data link settings, and satellites system 

settings.  

Start Up mode: There are two starting up modes, “use current coordinates” and “Input base coordinates”. 

Use current coordinates: Base station takes the WGS-84 coordinates of current point as the base station 

coordinates. 

Input base coordinates: The gap between input base coordinates and the accurate WGS-84 coordinates of 

current point should not be too large, otherwise the base station cannot work properly. 

If you select “Input base coordinates”, Please click “Set base coordinates” to enter the base coordinates settings 

page shown as next figure. There are three ways to input the base coordinates: search coordinates from library, 

get current GPS coordinates and input the coordinates manually. Then click “Set base antenna height” to set the 

antenna parameters.  
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Measured height: The distance from the measured point to the ground. 

Antenna height: Vertical height (h) from the antenna phase center to ground. 

 

The known values which receiver provided are: 

b: the height from the bottom of the device to the phase center (p.c.);   

c: the height from the bottom of the device (ARP) to the rubber ring (SHMP);  

R: the radius of the device rubber ring ( R ). 
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If the measured height is the vertical height (a) from the bottom of device to the ground, the measured mode is 

“Vertical height”. And the antenna height: h = a + b. 

If the measured height is the slant height (s) from the rubber ring to the ground, the measured mode is Slant 

height.  Antenna height h = sqrt (s² - R²) - c + b (sqrt means square root). 

In option settings, you can set the Base ID, PDOP limit, Delay starts time, difference mode, cut-off angle and if 

to record raw data. 

Data Link: There are four communication modes in datalink, including no data link, internal network, internal 

radio, external radio. Please refer to next figure. 

 

None: No differential data is sent. 

Internal Network: Transmitting differential data through network, the receiver should be inserted in SIM card 

to transmit data. 

Internal Radio: Transmitting differential data through internal radio. RTK base and rover are all with built-in 

radio, which could receive and transmit differential data.  Base could transmit differential data through internal 

radio, and rover could receive differential data through internal radio. 

External Radio: The receiver is connected to external radio and transmitting differential data through the 

external radio. 

After all parameters of base have been set, please click "Save to Configurations" to store the parameters. The 

base parameters of the current mode could be saved to the file, so that you can recall the configurations next 

time when you need. The configuration name could be set by users. 

After the parameters in the base mode settings are set, click "Apply" to change the working mode of the receiver 

to base. 
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4.1.4.4. Rover Mode 

Click “Device – Working Mode - Rover” to enter the “Rover mode settings” page shown as next figure. The Rover 

mode settings contain four aspects: option settings, data link settings, antenna parameters settings and satellites 

system settings. 

 

Options settings: If you enable the option “record raw data”, you can set the number of points names. Then 

you can collect the “Stop and go points” in point survey page. 

Data Link: There are six communication modes in datalink, including no data link(none), internal network, 

internal radio, external radio, phone network and L-band. Please refer to next figure. 

The meaning of none, internal network, internal radio, external radio is same with which in base mode settings. 

Phone Network: Transmitting differential data through the network of handheld. In this communication mode, 

the handheld should be inserted in SIM card or connected to Wi-Fi. 

L-band: Using the Chinese precision satellite-based enhancement system, the geostationary communication 

satellite L-band broadcast differential signal, to achieve stand-alone 5-12 cm accuracy. Do not relies on ground 

base stations, CORS or network, in the non-differential signal area, desert, ocean, mountain, no differential signal 

area fast stand-alone positioning, easy to achieve high precision. 

After the parameters have been set, please click “apply” to change the working mode to rover mode, then the 

rover could receive the differential data from the base. If the communication mode is radio, the frequency and 

protocol of base and rover should be the same. 
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4.1.4.5. NMEA  

Inside NMEA menu is possible set the NMEA output of the single messages. 

Obviously following the maximum rate available of the specific unit. 
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4.1.4.6. Saved Configuration 

Click “device – working mode – preset configurations” to enter the “preset configurations” interface shown as 

next figure. If all configurations of various working mode of current project are saved, then these configurations 

can be viewed in this menu.  

  

If you select one configuration and click “OK”, then device will work with the configuration which you selected. 

 If you select one configuration and click “details”, then all parameters of this configuration will be displayed.  

If you select one configuration and click “delete”, then this configuration will be deleted. 

 

4.1.4.7. Data Link Settings 

Data link settings is mainly used to set the data transmission mode between the base and the rover. Click “device-

> data link settings”, there are two options in the data link settings menu, current working mode, and data link 

settings, please refer to next figure. Depending on the different working mode, the data link settings are divided 

into two types, base data link settings and rover data link settings. 

When current working mode is base, there are four data link modules, including None, internal network, internal 

radio, external radio. Please refer to next figure. 

When current working mode is rover, there are six data link modules, including None, internal network, internal 

radio, external radio, phone network and L-band. Please refer to next figure. 

After you select the data link module, you can click the button below the data link module to set corresponding 

parameters. 
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7   

 

 

4.1.4.8. Internal Network 

There are two kinds of network, internal network and phone network. When the working mode is base, the network 

only can be the internal network. When the working mode is rover, the network could be internal network and 

phone network. 

When you select internal network in base mode, the content of settings includes connect mode, connect options, 

network mode, APN settings, CORS settings. When you select internal network in rover mode, the content of settings 

includes connect mode, connect options, network mode, APN settings, CORS settings, mountpoint settings, CORS 

account, get mountpoint settings. When you select phone network in rover mode, the content of settings includes 

connect mode, CORS settings, CORS account, and mountpoint. 
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TCP: Transmission control protocol, a communication protocol which is connection-oriented, reliable and byte-

based. 

NTRIP: Through internet protocol, a standard protocol used to transmit differential data via network, always used 

for CORS network. 

Custom: User defined. 

In “connect options” settings, the default value of GGA upload interval is 5s, and you can also set the GGA upload 

interval to other values. You can enable/disable the “Automatically connect to network”. In rover mode, you can set 

the “network relay”. 

In “APN settings”, you can set the operator/name/user/password of the SIM card in receiver. Some settings are 

preloaded as shown in next figure. In addition, you can click the  on the right side to add or edit custom SIM 

card information.  

 

Base network settings: Please set the IP, port, base access point (In general, the base access point is the device 

serial number of the base) and password in CORS settings. In addition, you can click the  on the right side to 

add or edit the parameters of the CORS server. 
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Rover network settings: Please set the IP and port in CORS settings, and you can also click  on the right side 

to add or edit the parameters of the CORS server. Some CORS settings have been preloaded in the software as 

shown in next figure.  

Then set the mountpoint, you can use “RTK network” or “mobile phone network” to get the mountpoint and select 

a mountpoint in mountpoint settings. At last, set the user and password in CORS account. If the base is set up by 

yourself, the user and password could be entered as any characters. But if you are using someone else’s CORS 

account, please enter the corresponding user and password. 

Click “Ok”, you will finish the base network settings or the rover network settings.  

 

Note: The IP in base and rover network settings should be the same. 

 

4.1.4.9. Internal Radio 

Select the data link as “Internal Radio”, then click “internal radio” to set the parameters. The parameters in base and 

rover mode are the same, including channel, frequency and protocol. The channel 1-7 are the fixed channel, the 

frequency can’t be modified; the channel 8 is the customized channel, the frequency could be set as your actual 

need. Click “default radio settings”, you could set the frequency of 1-8 channel. 

If the datalink of base and rover is internal radio, the frequency and protocol of base and rover should be the same. 

In base mode, the radio power will affect the transmission distance of the single. Low power, low power 

consumption, the signal transmission distance is close; High power, high power consumption, the signal 

transmission distance is far. 
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4.1.4.10. External Radio 

Select the datalink as “external radio” and click external radio to set the parameters. The external radio parameters 

of base and rover mode are the same, only need to set the baud rate. The default value of bard rate is 38400. 

 

 

4.1.4.11.  Phone Network 

Phone network is only available in rover mode. Please select the datalink as “phone network” and click the phone 

network to set the parameters (next figure), the parameters include CORS settings and mountpoint. If you click  

on the right side of the CORS settings, you can add or edit the parameters of the CORS server.  

These settings are the same as the internal network mode, except that network used in phone network mode is 

from the mobile device (handheld), which requires mobile devices to access the internet. 
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4.1.5 Information 

Contains the detailed parameters and status of device, antenna, network, radio and satellites systems. Please refer 

to next figure.  

 

 

4.1.6 RTK Reset 

Its function is to force an OEM board re-initialization, thus, to force a complete recalculation of the location starting 

from fresh satellite signals. Click “Re_ position”, there will be the prompt dialog box shown as in next figure, then 

click “Ok”, receiver will restart positioning. 
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4.1.7 Register 

You can view the device serial number and registration date in this interface. “Register” is to register the RTK, and 

when the receiver is connected with the Cube-a, then you can enter the activation code and click “registration” to 

register the RTK. 

 

 

4.1.8 Wifi Mode Settings 

To change the Wi-Fi settings of the receiver the user can open this menu and change the status of the connection. 

Status available are two: 

• Master 

 

• Client 

 



 

 

          Stonex Cube-a 5.x – User Manual   41 

If the user sets Master, the receiver wifi will be available for configuration instead if he sets the mode Client, the wifi 

of the receiver will connected to a Master Wifi device and the connection to the web UI won’t be available. 

 

4.1.9 Distance Meter 

The Cube-a supports the connection to a disto to measure length on field. 

To pair the device, select the model, Stonex or Leica and Search the disto via Bluetooth. 
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4.2 Total Station 

4.2.1  Total Station Communication 

Click “Device” -> “Total Station Communication”, there will be the page shown in next Figure. Communication 

settings are mainly used to select the communication mode between total station and Cube-a software.  

Select the “Device Type” between Stonex R15, R25 and R80 models:  

 

1. Bluetooth connection 

Select "Bluetooth" communication mode in the communication settings interface, and then click "Search", you 

will see the page shown below. If you already have a Bluetooth device in the list that you want to connect to, 

you can click "Stop" to stop searching, and select the name of the Bluetooth device to connect to the Device, 

click "Connect". When the Matching dialog box appears, please click “pair” and it could be connected 

successfully. 

 

2. Demo Mode 

When you select the communication mode as “Demo”, then click “Connect” to enter the demo mode. You can try 

and view each function and do not need to connect the total station. NOTE: Demo Mode works with R80 as Device 

Type only. 

 

NOTE: to successfully connect the total station and the controller check if:  
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• (For R15 and R25 only) You have set the following command settings: 

o Baudrate: 9600 

o Bluetooth: ON 

• You have levelled the total station 

• (For R15 and R25 only) You are in the measure page.  

You will have confirmation that the connection has been successful if the angles’ values are shown in the bar 

status. 
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5. Survey 
 

This chapter provides information on using the commands from the survey menu. You will see some submenus after 

you click “Survey”, including Point Survey, Point Stakeout, Line Stakeout, Elevation Control, Stakeout by designed lines 

and View in Google Earth.  

 

 

5.1 Point Survey 

Click “Survey” -> “Point Survey” to enter the user interface of point survey. Some commands may change in this 

page, depending on which modules of Cube-a you are currently using and enabled. This chapter will explain the 

common commands in all modules. Refer to subchapter Point Survey with GPS, GIS Survey and Point Survey with 

Total Station for the description of the commands specific to each module. 
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Zoom in on the map 

  

 

Adapt all the survey in the screen  

  

 

Zoom out on the map 

  

 

Compass showing the magnetic north. The compass information comes from the controller where 

cube-a is installed. 

 

 
  

 

Evaluate distances and area between points on the map. Tap on it to enable the tool: the icon becomes 

yellow and you can tap on the map to define the first point. Distance between two segments is shown 

in green on the center of the segment, progressive distances are shown in green on the points and 

the area is in red in the center of the geometry. 

 

 
 

Tap again on the yellow icon to exit the tool: measures will disappear.  

  



 

 

          Stonex Cube-a 5.x – User Manual   46 

 
Enable the tool and select a line on the map and you will enter the Line Stakeout. 

  

 

Enable the tool and select a point on the map and you will enter the following page: 

 

Where, after selecting the point from the list, you can tap on to enter the Point Stakeout.  

Otherwise you can check Details, Edit or Delete the point; if the point is a vertex of a CAD entity, you 

can Add or Delete vertex.  

  

 

Change the Google maps type: 

•  disable the map; 

•  set the predefined map; 

•  set the satellite map. 

 

 

Enable the tool to keep the current point in the center of the screen. Tap on it to disable it and to be 

free to move on all the map; the following icon will be shown . 

  

 

Remove all the icons from the screen, leaving only the button to register points. To restore the icons, 

tap on the upward arrow . 

  

 

Define the drawing tools to draw vector CAD elements while you survey. Refer to Draw while 

acquiring points. 

  

 

Define the type of point you will survey: 

 
 

• GPS mode: refer to Record Settings; 

• TS mode: Topo point is only available. 
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Quickly define the code by scrolling through the available ones: 

 

 
 

The list of codes comes from the library you had chosen in Feature Codes. 

  

 

Enter the Survey tools page. 

  

 

If you are working with the drawing tools, you can close entities.  

  

 

Enter the Point Library. 

  

  

In the lower part of the screen, you can define: 

 

1) the name for the next point. Insert the name in the cell or increase/decrease it using the +1/+1/+10/-10. 

The icon  uses the name next to the last measured point name. 

 

 

2) the code for the next point. You can search the code entering the name or scrolling the list or enter a code 

which does not exist on the Code Library. You can search by code (e.g CL) or by the code name (e.g. Center 

Line). The  icon allows to enter the Feature Codes. Choose if you want to save the code or the name in the 

fieldbook of measures.   
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3) the antenna/pole height for the next point.  

If you are working with GPS, you can choose between: 

  

• Vertical height: b 

• Height to phase center: h 

• Slant height to altimetry line: s 

• Slant height to altimetry plate: p 

 

If you are working with Total station, the value refers to the pole height.  

NOTE: only enter the height of the pole if in the prism settings (refer to Total station Settings) you already 

considered the vertical offset of the prism. 
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5.1.1 Point Survey with GPS 

Click “Survey” -> “Point Survey” to enter the user interface of point survey. If you are in GPS mode, you will have 

the following screen.  

 

In addition to the tools described in Point Survey chapter, in GPS mode you have: 

 

It collects point coordinate by using the recording type you have selected.  

 

5.1.2 GIS Survey 

If the GIS option is enabled, when you save a point or a CAD entity, Enter GIS Attributes window appears. Here you 

can choose the feature class clicking on the right arrow or left and insert the attributes. Click on Cancel to cancel 

the inserted attributes or click on OK to confirm. 
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5.1.3 Point Survey with Total Station 

Click “Survey” -> “Point Survey” to enter the user interface of point survey. If you are in total station mode, you will 

have the following screen.  

 

When creating the project, the MEAS and REC icons are red because the station has not yet been declared. Cube-a 

will not allow you to survey points, but tapping on one of them, you will have the following popup which will 

direct you to the station definition. Click on Yes and refer to Total Station  

Station on point and Resection/Free Station chapters.  

 

Going back to the survey page, in addition to the tools described in Point Survey chapter, in total station mode 

you have: 
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It measures distance. 

 

It saves the point if a measure has already been performed, otherwise it measures and save the point.  

 

It stops the tracking measure mode or the prism search.  

 

It rotates the telescope to the position of the point. It can be used during the survey, after that the 

station position and its orientation has been defined. 

 

It rotates the telescope to the direction of the GPS. It can be used during the survey, after that the 

station position and its orientation has been defined; it works if you own the GPS module of Cube-a 

and if the antenna is in fixed solution. 

 

5.1.4 Draw while acquiring points 

It is possible to draw vector CAD elements while surveying points. The vertices of the vector CAD elements are the 

points acquired while a drawing tool is active.  

To activate a drawing tool, refer to the “popup” tools grid as shown in following figure. 

 

 

It enables the “standard acquisition”, the simple point acquisition. No vector CAD entities will be 

created. 

 

It enables the acquisition of polylines. While this tool is active, the program will connect all acquired 

points to form a polyline. Tap the button to end the acquisition of the polyline. 

 

It enables the acquisition of parcels/closed polylines. While this tool is active, the program will connect 

all acquired points to form a polygon. Tap the button to end the acquisition of the polygon. 
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It enables the acquisition of a square by means of two acquired points which are at the extremes of the 

diagonal of the square. The acquisition automatically ends as soon as the second point has been 

acquired. 

 

Enables the acquisition of a rectangle by means of two acquired points that defined the end points of 

one side plus a third point that defines the distance of the opposite parallel side. The acquisition 

automatically ends as soon as the third point has been acquired. 

 

It enables the acquisition of a rectangle by means of 3 acquired points: the first point defines the 

“center” of the rectangle, the second point defines the position of the midpoint of one of the sides, the 

third point defines the position of the midpoint of one of the two orthogonal sides to the previous side. 

The acquisition automatically ends as soon as the 3rd point has been acquired. 

 

It enables the acquisition of an arc of circle by means of the acquisition of 3 points that define (in 

order) the starting point of the arc, a constraint point for which the arc must pass through, the end point 

of the arc. The acquisition automatically ends as soon as the third point has been acquired. The 3 points 

must not be aligned along a straight line. 

 

It enables the acquisition of a circle by means of 2 acquired points: the first point defines the center of 

the circle; the second point defines the radius of the circle. The acquisition automatically ends as soon as 

the second point has been acquired. 

 

It enables the acquisition of a circle feature by means of 3 acquired points: the 3 points must be 

acquired in order, walking either in a clockwise or anti-clockwise direction along the circular feature to 

be acquired. The acquisition automatically ends as soon as the third point has been acquired. The 3 

points must not be aligned along a straight line. 

 

It commits or cancels the entity. The action performed by this button depends on the kind of the active 

drawing tool and on how many points/vertices have been already stored. See the table below 

 

It enters the Survey tools, where you can find some helper commands. 

 

Drawing Tool 
# of vertices 

stored 
COMMIT action 

 
- None 

 
< 2 Cancel acquisition 

 
>= 2 Store & Restart 

 
< 3 Cancel acquisition 

 
>= 3 Store & Restart 

 
< 2 Cancel acquisition 

 
< 3 Cancel acquisition 

 
< 3 Cancel acquisition 

 
< 3 Cancel acquisition 

 
< 2 Cancel acquisition 
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< 3 Cancel acquisition 

 

 

5.1.5 Survey tools 

By clicking the  icon from Survey or Stakeout pages. You may have the following tools: 

 

CAD Layers It enters the CAD layers management:  

 

 

Layer “0” is by default and it cannot be 

renamed/deleted.  

Each layer you can set as visible/no visible, 

locked/no locked and you can modify color, 

line type and symbol for points.  

 
Entity list Refer to Entity List. 

   

 

Sensor Options Refer to Sensor Options. 

   

 

Audio Settings It allows to enable/disable cube-a and GPS voices: 

 

 
 

 
Record Settings 

These settings change in accordance if you are surveying or staking out points 

or staking out lines: refer to Point stake out Record settings, Point stake out 

Record settings and Line stake out Record settings, respectively. 

   

 

Display Settings Refer to Display Settings. 

   

 

Use last 

collected point* 

If you Draw while acquiring points, you may need to use the last collected point 

as starting point of the entity you are drawing.  
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Use point from 

list* 

If you Draw while acquiring points, you may need to use a point from the list 

as point of the entity you are drawing. 

   

 

Use point from 

CAD* 

If you Draw while acquiring points, you may need to use a point from the 

CAD/map as point of the entity you are drawing. 

   

 

Pause entity – 

Collect points* 

If you Draw while acquiring points, you may need to pause the drawing in 

order to collect some points which are not part of your drawing.  

   

 

Resume paused 

entity* 

If you Draw while acquiring points and you paused the entity, you may need 

to restore the acquisition of points of the entity you were drawing. 

 

Distance* Refer to Distance. 

   

 

Hidden Point – 

Dist-Dist* 
Refer to Hidden Point - Two Points Two Distances. 

   

 

Hidden Point - 

Two alignment* 
Refer to 2 Alignments Interception. 

   

 

Pt by Polar 

(from Dir)* 
Refer to Point by Polar (from Direction). 

   

 

Point averaging* Refer to Point averaging. 

 

5.1.5.1 Point stake out Record settings  

Entering the Record settings from the point stake out page, you will have to define the following values:  

 

• Store uses original point name: enable or disable it, depending if you want to store staked out point with 

the same original name or not; 

 
* Available only from the Survey page 
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• Prompt Range: on the screen you can see three concentric purple circles around the point (the center is 

the point to be stake out). Define the range (maximum distance from the point) to see them; 

• Display Track: display it to see dots of the last positions (track of the executed path). 

• Display Information: select which information you want to see on the display (NoDisplay, Point Name or 

Point Code); 

• 2D tolerance: enter the tolerance for planimetry; 

• Z tolerance: enter the tolerance for the elevation.  

By clicking on “Restore default settings”, the point stake out configuration will be reset to default configuration.  

 

5.1.5.2 Line stake out Record settings 

Entering the Record settings from the line stake out page, you will have to define the following values:  

 

• Graphical aid indicators spacing: it is the space between the reference lines added to the side of the line 

to stake out; 

• Chainage Prompt Range: it is the step for displaying the progressive along the line; 

• Waring range: it alerts you are approach to destination point, when you enter within the distance you 

have set. If you move away alerts you are moving away from the point of destination; 

• Display track: display it to see dots of the last positions (track of the executed path).  

 

5.1.6 Photo and Sketch 

The Photo and Sketch feature allows you to associate a photo to a point. 

To launch Photo and Sketch command you must push the relative button that you can find in the bottom part of 

the screen , while you are: 

1. reviewing the details of point that you just collected. 

2. editing the data of a point from the Survey Points Library. 

The photo will be taken using the integrated camera of the handheld and it will be stored in a jpg file in the 

Photos folder of the active project. 
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The image file will have the name equal to the name of the collected point. 

You can also draw over the image and insert: 

• Text notes 

• Point information (name, coordinates) 

• Arrows 

• Simple sketches (polylines drawn by hand). 

Any of the above elements can be freely moved and rotated. 

Images can also be re-shot or deleted. 

 

 

5.1.7 TS control panel 

Enter the Total station control panel using the following icon . It contains three sub-menus (Settings, Rotation 

and Search) if you are working with a Motorized Total Station or only Settings if you are working with a Manual Total 

Station.  
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5.1.7.1 Total station Settings 

Define the settings of the total station. They may change depending on the total station model. 

• Laser pointer: it can be switched off  / switched on . 

• Target type, define:  

o No Prism  if you are measuring in reflectorless mode 

o Reflector  if you are measuring a reflector sheet 

o Prism  till 2.500 meters 

o Remote Prism between 2.500 and 5.000 meters. 

• Measure mode:  

o Single - Fine : total station will take a single and precise measure 

o Tracking - Fine : total station will continue taking precise measures, till you stop it 

o Tracking - Coarse : total station will continue taking raw measures, till you stop it 

o Tracking – Coarse + Fine shot : total station will continue taking raw measures, till you take a 

measure which will be performed in precise mode 

o Averaging (3) : total station will take 3 measures and Cube-a will average them 

o Averaging (?) : total station will take n measures and Cube-a will average them. Tapping on it, you 

have to enter the number of measures you want to perform.  

• Autotarget: it can be enabled  /disabled . If enabled it corrects the decentralization of the target 

with respect to the axis of aim: it calculates angular corrections (horizontal and vertical) in order to correct 
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the angles without having to aim exactly at the center of the prism. If Autotarget is enables, lock is disabled 

and vice versa.  

• Prism lock: it can be enabled  /disabled. . Enable it only if you are using a prism as target type. 

• Electronic Guide Light: it can be enabled (3 levels available)  /disabled . 

• Laser Plummet: it can be enabled (3 levels available)  /disabled . 

• Prism type : select the model of your prism from the window or choose the CUSTOM prism to insert 

your own offset values.  

NOTE: since Vertical offset of prism is define on this page, this value should not be considered during the 

survey; when you set the Target height, insert the pole height only.  
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5.1.7.2 Total station Rotation 

Manage the Motorized Total Station by remote. You can rotate the telescope Up  / Down  / Left  / Right 

; movements can be arrested by tapping on STOP . 

From this page you can also change instrument face  (from left to right face and vice versa). 

 

 

5.1.7.3 Total station search 

Manage the prism search of Motorized Total Station. You can start the prism search up  / down  / left  

/right  or defining a window  of ever larger dimensions, starting from the point where the telescope is located.  

The Search near GPS  and Search near Point commands allow to rotate the telescope to the direction of the 

GPS or to the position of the point, respectively. They can be used during the survey, after that the station position 

and its orientation has been defined. Search near GPS works if you own the GPS module of Cube-a and if the 

antenna is in fixed solution.  

Tap everywhere on the screen to stop the search. If the prism search is successful and lock setting has been enabled, 

the prism will remain locked. 
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5.2 Point Stakeout 

Click “Survey” -> “Point Survey” to enter the points library, then select one point and click “OK” to enter the stake 

point interface shown as next figure.  

 

In addition to the tools you find in the Point Survey page, there are: 

 

Zoom on your position and on the point you are staking out. 

  

 

Define the item to use as reference during the stake out. 

If you are working with a GPS, you will have:  
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• North: referring to the compass, the magnetic north has to 

be in front of you; 

• South: referring to the compass, the magnetic south has to 

be in front of you; 

• Sun: the sun has to be in front of you; 

• Shadow: the sun has to be behind you; 

• Point: choose a point from your survey to refer to. The 

Point Library opens to select the point; 

• Line: choose a line to refer to. The line must be defined 

choosing two points from your survey. Enable the point 

selection by tapping on blue hand  icon. Below the list, 

have to Set stakeout ref. pt 1 or 2, depending to which 

direction you want to give to your line: 

 

 
  

If you are working with a Total station, in addition to GPS you will have: 

 

 

 

• Station (2-man): choose these setting if 2 men are in the 

field: one person measures at the total station and gives 

instructions to the second man which holds the pole with 

the prism. This mode is very common if you are working 

with a manual total station; 

• Station (1-man): choose these setting if a single surveyor 

is staking out. He has to refer to the total station position 

and move holding the pole with the prism. This mode is 

very common if you are working with a motorized/robotic 

total station. 

  

 

It shows the current position on the map by using a red arrow. 

The point to stake out is highlighted with a red and blue circle 

and a purple line connecting the position and the point shows 

the distance.  
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It shows the direction in which you are moving by a blue 

arrow and the distance between the current position and the 

point to stake out.  

 
 

 

1) Move backward  or forward  for the distance shown so that you find the point: once found with 

the declared tolerance, the arrow will become green  

2) Move to the right  or to the left  for the distance shown so that you find the point: once found 

with the declared tolerance, the arrow will become green  

3) It shows the elevation of the point you are staking out: the point can be upwards  or downwards  

And it will suggest you cut or fill: once found the correct position with the declared tolerance, the arrow 

will become green  

4) ID of the point you are staking out 

5) Stake out the previous point 

6) Stake out the next point 

7) Enter the point library to select another point.  

 

5.3 Line Stakeout 

Click “Survey” -> “Line Stakeout” to enter the lines library and select one line. 

If you want to stake out a line coming from a *.dxf file, consider that lines from *.dxf are not listed in the line library, 

but it has to be selected from the map using the  icon.  

You will have the following option: 
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• Leaving it disabled  you will stake out the line: it will not matter which point of the line you will 

find, simply position yourself on the line to consider the operation finished. 

 

The current position is shown with a red dot & circle , the line to stake out is in red as well, with 

indications of the starting point (0.000) and the end point (e.g. 5.000), and you can see the projection of 

the current position on the line indicated by the following icon:  

The tools on the page are the same as on Point Stakeout, with exception for: 

 /  Stake out the previous/next line. 

  

 

It shows the position along the line: it can be positive (if between the starting and 

the end points) or negative (if before the starting point). 

 

• Enabling it  you will stake out points on the line or offsets from the line. You have to define the 

following parameters:  
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• Chainage: entering N value you add a point along the line at distance N from the starting point.  

• Range: it shows the starting and end point of the line you are staking out. It is a no-editable value 

• Divide given the number of parts: ticking it, whatever is the length of the line, it will be divided into N 

equal intervals (value defined in the Interval cell). With the parameters shown on screen, the line will be 

divided as: 0.000 – 1.071 – 2.143 – 3.214 – 4.285 – 5.356. 

• Divide given the part length: ticking it, whatever is the length of the line, it will be divided into N wide 

intervals (value defined in the Interval cell). With the parameters shown on screen, the line will be divided 

as: 0.000 – 5.000 – 5.356. 

 

The current position is shown with a red dot & circle , the line to stake out is in red as well, with 

indication of the subdivision points of the line  and the currently selected point .  

The tools on the page are the same as on Point Stakeout, with exception for: 
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/  Stake out the previous/next line. 

  

/  Stake out the previous/next point on the line. 

  

 

Define offsets for the stakeout. You can: 

• Calculate coordinates by chainage and offset distance 

 

         
 

Chainage is the distance along the line starting from point 0 of the line 

Offset distance is the lateral offset with respect the line 

Offset angle is the direction for the lateral offset. Referring to the line direction: 90° 

means on the right, 270° on the left 

 

• Calculate offset and distance by coordinates 

 

 
Enter the coordinates or use coordinates from existing point or use current GPS 

position. 
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5.4 Elevation control 

The elevation control feature allows the user to check the elevation live on field calculated by the device respect 4 

different referments. 

 

User can check the elevation respect a triangulation file in.dxf file. To set it, it is necessary import a .dxf and then 

select it. 

It is possible check the elevation respects a plane defined per 3 points. To do that select Triangle and choose the 

points. 

 

The user can also set a referment a slant plane per 2 point or a horizontal plane per 1 point. If the user set a plane 

per 2 points, there is also the possibility to set the slope instead if the choice is Plane per 1 point, the slope can be 

set in direction x,y. 
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After the importation of the file or the definition of the plane, to start the elevation check press Stakeout. 

You will always have the elevation different respect the current position and the referment set before. 

 

5.5 Stakeout by design lines 

With this feature is possibly create parallel lines starting by one as referment and then stake all the lines. 

To do that open the tool and select Add. Then select Straight line to define the referment line. 

 

 

 

 

Then set the start point and the end point and give a name to the line. 
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Now to create the parallel lines select the referement line and press Add. A prompt menu will popup. In this menu 

the user can set the distance between the lines and the parallels on the right and on the left respect the referment 

line. After the confirm the user will have all the lines ready for the stake. 

  

 

To start the stake, select the line and press ok. 
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5.6 View in Google Earth 

This command opens immediately your current project in Google Earth. As is possible see from the screen here 

below, the Cube-a export and dialog with Google Earth exporting all features stored through a .kml file. 
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6. Configure 
 

Click “Configure”. It consists of 8 submenus, namely Coordinate System, Record Settings, Display Settings, System 

Settings, Survey Area Settings, Layers Settings, Administration and DXF Symbols Library. 

 

6.1 Coordinate System 

Local coordinate parameters 

Click “Configure”- “Coordinate System” as shown in next Figure. All options can be clicked in to set up the parameter. 

Click “Save” and choose “Local Disk” as shown in Figure to save system data to the specified path as shown in Figure. 

It can also encrypt the file by setting up Expiry Date, General Password (data cannot be viewed before expiry date) 

and Advance Password (data can be viewed before expiry date). Click “Save” and choose “QR Code” to share current 

coordinate system parameters. 

Click “Predefined Projections” as shown in Figure and choose “Local Disk” to import local-saved coordinate system 

parameters. It supports *.SP and *.EP files. Click “Predefined Projections” and choose “QR Code” to scan QR code to 

acquire coordinate system parameters. 

Ellipsoid Parameter: 

 As shown in Figure, it can set up Target ellipsoid and enable/disable ITRF conversion. Target ellipsoid supports 

defined or custom parameters. With custom ellipsoid, it needs to set up Semimajor axis and Reciprocal of flattening 

1/f, which should be consistent with the ellipsoid used for parameter calculation. To enable ITRF conversion, it needs 

to choose Conversion type, input Year of source coordinates and enable/disable Input velocity. If enabling Input 

velocity, it needs to input values for Vx, Vy and Vz as shown in Figure.  
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Projections Parameter  
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The frequently used projections mode is Gauss Kruger, and after connecting to the device the Central Meridian can 

be acquired automatically via a click on  or manually via inputting the exact value. Common projections 

parameters are set up as followed: False Northing-0, False Easting-500000, Scale Factor-1, Projection Height-0 at 

low altitudes and change it as needed at high altitudes, Latitude of Origin-0. 

Seven-parameter, Four-parameter/Horizontal Adjustment, Vertical Control Parameter, Vertical Adjustment 

Parameter and Local Offsets can be set up as needed. 

1. RTCM1021~1027 Parameters 

RTCM1021~1027 is a way to send coordinate system parameters via differential data. When coordinate system 

parameters type is set up as RTCM1021~1027 parameters in project creation, the software analyses coordinate 

parameters received with the differential data. In this mode, parameters cannot be set manually. 

 

6.2 Record Settings 

Click “Configure”- “Record Settings” as shown in Figure. It can set up Saved Conditions and Record Options of Topo 

Point, Control Point, Quick Point, Auto Point and Corner Point. It can set up Code and choose Point Name Increment. 

It also supports Default Configurations. 

Code: it can choose the same as last point, Mileage assignment code and Code is empty by default. 

Point Name Increment: naming rule for saved points. For instance, Point Name Increment is 2, then the default 

point name of the first saved point is pt1, the second is pt3, and so on. 

 

Topo point: The “average GPS count” in record options refers to the number of points which could be 

consecutive recorded. Please refer to the next Figure, it means that it could collect one point every time and this 

point should meet the saved conditions. When you click  to record the topo point, if the RTK does not meet 

the saved conditions, there will be a prompt message. If the RTK meet the saved conditions, the measurement 

point info (HRMS, VRMS, delay, PDOP…) will be displayed in the screen. Then click OK to save the topo point. 
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Control point: In the control point settings interface, you can set the saved conditions and record options of 

control point, please refer to last Figure. In record options, we can set the parameters average GPS count, 

Average GPS interval, repeat count and fixed delay. If the fixed delay is 15, it means that it should wait for 15s 

after you click  to record control point. If the average GPS interval is 2s and average GPS count is 10, it means 

that it could record a point every 2s and continuous record 10 points. If the repeat count is 2, it will collect 2 

data sets. After the control points collection is finished, there will pop-up the prompt “The control point report 

has been generated” when you click “OK”. If you want to view the report, please click “OK”. 
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Quick point: When you collect the quick point, if the RTK meet the saved conditions, then the quick point will 

be collected after you click , and there will not pop-up the saved interface. 

Auto point: When the record mode is “record according to time” and interval is 5s, it means that recording a 

point every 5s. Click  to record the auto points, and if you want to pause the recording progress, please click 

“pause”. Then if you want to start recording, please press “start”. And you can click “close” to end the auto points 

recording. 

Corner point: In corner point settings interface, you can set the saved conditions and average GPS count. Every 

time you record the corner point, you should record at least 15 points, and the distance between one point and 

another point should be greater than 1/10 of pole height.  Then you can calculate the coordinates of the ball 

center by these corner points, the coordinates of the ball center are the corner point coordinates which you 

record. 
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6.3 Display Settings 

Click “Configure”- “Display Settings” as shown in Figure. Display Settings is for display set up on coordinates 

displayed in Survey interface. It can set up Display Content and Display Type as needed. 

Display Content: Display Point Name, Display Code. 

Display Type: Display All Points, Display Specified Point/Code, Display Last (0 to 100) Points. 

 

6.4 System Settings 

Click “Configure”- “System Settings” as shown in Figure. It can set up Time Zone, Solution, Units, Stakeout Voice 

Prompt, Base Prompt, Tilt Survey, Device, Shortcut Key, Stakeout Shortcut Key and Map and other more things. 
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Units Settings: Distance Unit can be set up as Meter, US Survey Feet, or International Feet. Angle Unit is 

ddd.mmssss. It can set up units according to different environment. 

 

Time Zone Settings: set up device’s Current Time Zone. The user can choose also to set it automatically following 

the OS time. 

Sensor options: user can enable/disable the use of the e-bubble/IMU following the configurations available on the 

specific receiver. To enable the e-bubble/pole tilt correction feature is enough select it and confirm with ok. Inside 

this menu is possible also define a maximum tilt angle to consider the pole in vertical. So, this will be the tolerance 

for the verticality of the pole during the survey. Within this limit the software will consider the pole vertical then will 

proceed eventually with the measure of the points. 

There is also the possibility to set the automatically collection of points if the pole is assumed to be in vertical 

respecting the limit set. 

It is possible shows during the survey the live tilt angle of the receiver. 

If the user prefers, there is also the opportunity to shows the animations of the initialization of the IMU sensor every 

time it goes out calibration during the survey. Once the user knows how to work with the sensor is possible disable 

them remove the check on this option. 
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Audio Settings: this menu is to enable/disable the vocal messages of the receiver and software. User can customize 

the configuration following his needs. 

 

More GPS settings: Here the user can choose as solution mode the normal mode or the strict mode in base of the 

survey is doing. In the specific it is possible enable for the receivers with Novatel board the extra-safe mode or the 

SureFix mode for the receivers with the Hemisphere board inside. 

Always for receivers with the Hemisphere board inside it can be set the L-Band zone following the position in use 

on field. 

 

Shortcut keys: it sets up shortcut keys for Topo Point, Control Point, Quick Point, Auto Point and Corner Point. For 

P9A, default shortcut keys are respectively (1) for Topo Point, (2) for Control Point, (3) for Quick Point, (4) for Auto 

Point, and (5) for Corner Point. It also supports custom defined. 



 

 

          Stonex Cube-a 5.x – User Manual   78 

 

Map provider: in map provider is possible select the map services preferred between different map providers. 

Services supported are: 

- Google Map 

- Open Street Map 

- Bing 

It is possible also set the opacity level of the map in background setting the level of the opacity. 

Last check is for enable the rotation of the map following the compass angle. If it is disabled, the map will be fixed 

respect the North. 

 

More Settings: here is possible enable the mock location feature. This will require the restart of the application 
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6.5 Survey Area Settings 

Click “Configure”- “Survey Settings” as shown in Figure. Click “Add” to set up Point Coordinates or Search 

coordinates from library or Get current GPS coordinates. Generally, survey area set up needs at least three points. 

Points can be chosen to edit and delete. Click “Import” to import coordinates files (*.dat, *.txt, *.csv). Survey area 

shall display with red lines in measurement interface after survey area set up, as shown in Figure. It can check if the 

current point is in survey area when in survey. 
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6.6 Layers Settings 

Click “Configure”- “Layers Settings” as shown in Figure. Click “Add” to import layer. It supports *.shp (ArcGIS™ data 

type) and *.dxf (AutoCAD™® drawing exchange file) files. Choose layer and click “Edit” to edit Layer properties as 

shown in Figure. It can set up Contour Color and Fill Color, enable/disable layer properties display, choose which 

property to display and set up correspondent Text Color, choose if the layer visible and if selectable. Click “Boundary” 

to check the boundary of the layer as shown in Figure. 

Multiple layers can be overlapped. Layers can edit, deleted, moved up and down. It can view imported layers in 

Survey interface after Layer settings, as shown in Figure. 

In Survey, use  to choose layer and it shows Layer Element as shown in Figure. Click “Property” to check detailed 

layer element information. It can stakeout the chosen point on the layer via a click on “Stakeout”. It can save the 

chosen point to coordinate library via a click on “Save”. 

  

 

6.7 Administration 

In Administration menu is possible to set the visibility of the password used inside the software. 

Possibility are three: 

- Password showed 

- Password hided 

- Password hided but possible to be viewed 

When the user set this option, it is necessary also set a general password. 
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6.8 DXF Symbols library 

The DXF Symbols library is dedicated of the Symbols for the points. 

Inside the library as default is present the Standard group with 23 symbols for the points. 

The user can add a new library, edit a present library, create a duplicate or delete. It is possible also import and 

export libraries. 

Inside a selected library the user can see the preview of all symbols available. 

  

User can select a symbol and edit it changing the scale, the rotation, the color and the shape. After the modification 

select ok to confirm the changes.  
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7. Calibrate  
 

Click “Calibrate”, there will pop up the interfaces shown below.  

If you are in GPS mode, the Calibrate includes Site calibration, calibrate point, Change Station Coordinates, Sensor 

Options, Calibrate Sensor and RMS Study. 

If you are in Total Station mode, the Calibrate includes Station on point and Resection/Free Station.  

  

 

7.1 GPS 

7.1.1 Site Calibration 

In general, GPS receiver output data is WGS-84 latitude and longitude coordinates, the coordinates need to be 

converted to the construction measure coordinates, which requires coordinate conversion parameters are calculated 

and set the conversion parameters of software, it is the main tool to complete this work. 

There are three coordinates convert methods, including “four parameters + elev. correction”, “seven parameters + 

four parameters + elev. correction” and “seven parameters”. The user need to consider which method should be 

used based on the known point. 

Four parameters: At least two coordinates of control point should be known, which are in arbitrary coordinate 

system. It is the parameter that is used to perform a plane conversion between different coordinate systems within 

the same ellipsoid. Parameters include: four values (translate northing, translate easting, rotation and scale), the 

scale should be infinitely close to 1. 

Seven parameters: At least three coordinates of control point should be known, which are in arbitrary coordinate 

system. It is the parameter that is used to perform space rectangular coordinate transformation within different 

ellipsoids. Parameters include 7 values (ΔX, ΔY, ΔZ, Δα, Δβ, Δγ, scale). 
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In general, the control point distribution directly determines the level of high and low and four parameters to 

control. Using four parameters for RTK measurement method can be in a small range (20-30 square kilometers), 

make the measurement point in plane coordinate and cooperate between the precision of elevation control net 

with known very well, as long as the coordinate point collection of two or more than two places, but in a wide range 

of measure (for example, dozens of hundreds of square kilometers), transformation parameters often can't play for 

increasing accuracy of plane and elevation in part of the scope, seven parameter method should be used at this 

moment. 

You first need to make measurements and leveling control, in the area known control point coordinates do static 

control, and then the network adjustment prior to the survey area is selected a control point A as static net 

adjustment WGS84 reference station. Use A static Device at A fixed point measure single point positioning of more 

than 24 hours (this step in the test zone is relatively small, relatively low accuracy of cases can be omitted), and then 

imported into the software in single point positioning point at which total recorded, the average as A point of 

WGS84 coordinate, as A result of long time observation, the absolute accuracy should be within 2 meters, and then 

to three dimensional control network adjustment, you need take point A WGS84 coordinate as known coordinate, 

to calculate other points of 3 d coordinates, but at least more than three group, after the input to calculate the 

seven parameters. 

The four parameter is used to plane conversion, it also needs to horizontal adjustment. When using horizontal 

adjustment, if there are less than three points elevations used to calculate, the parameter of horizontal adjustment 

is weighted average. If there are 4-6 points elevations used to calculate, the parameter of horizontal adjustment is 

plane fitting. If there are more than 7 points elevations used to calculate, the parameter of horizontal adjustment is 

surface fitting. 

How to calculate the convert parameter? 

In general, if we use three known points A, B, C to calculate the conversion parameters, then first we should know 

the GPS original record WGS-84 coordinates and local coordinates of A, B, C three points. There are two methods 

to get the GPS original record WGS-84 coordinates of A, B, C points. First method set up static control network, then 

get the WGS 84 coordinates from the GPD recording of the post-processing software. Second method, GPS rover 

records the GPS original WGS-84 coordinates in a fixed solution when no correction parameters are active. 

Click calibrate -> site calibrate, there will be the interface shown as Figure. You can do eight operations in this 

interface, including add, edit, delete, options, calculate, import, export and close. 
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Click “Add”, there will pop-up the interface shown as Figure. 

There are two methods to set the know point coordinates: first method, click  to get the coordinates from the 

points library; second method, input the name, northing, easting and elevation directly. 

Then set the WGS84 geodetic coordinates and click “OK” to add the first group of coordinates. The remaining 

coordinates can be added in this way, until you have added all the coordinates which are participated in the 

parameter calculation. 

Select a coordinate in “Site calibration” and click “edit”, you can edit the parameters of this point, including known 

coordinates, WGS84 geodetic coordinates and options. Then click “OK” to save the changes. 

Select a coordinate in “Site calibration” and click “delete”, then all the data about this point could be deleted from 

site calibration. 

Click “Options”, there will pop up the site calibration settings shown as Figure. There are three coordinates convert 

methods, including “four parameters + elev. correction”, “seven parameter + four parameters + elev. correction” 

and “seven parameters”. The four parameters model includes “horizontal adjustment” and “four parameters”. 

Vertical control includes “weighted average”, “plane fitting”, “surface fitting”. The “horizontal accuracy limit” and 

“vertical accuracy limit” can be changed according to actual needs. 

Click “Import”, you can import the “* .COT” file, which convenient coordinate input. 

Click “export”, you can export and save the coordinates in site calibration to “* .COT” file. When you need to use 

these coordinates next time, you can import and don’t need to re-input. 

After all the coordinates are entered, please click “calculate”, there will pop up the GPS parameter report shown as 

Figure. Click “return”, it will return to the site calibration interface, and when you click “Close”, there will pop up the 

prompt “are you sure to apply calculated parameter model to the current project?” shown as Figure. If you want to 

apply this parameter, please click “OK”. If you don’t like to apply this parameter, please click “cancel”. 

After you apply the parameter, the original WGS-84 coordinates in the current project points library will be 

converted to the same coordinate system coordinates as the known points according to the parameters. Whether 

the calculation results are accurate or reliable, it can be checked by going to another known point. 
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7.1.2 Calibrate Point 

Click calibrate-> calibrate point, there will pop up the interface as shown in Figure. Cube-a has two kinds of calibrate 

point methods. Base point calibration, using the base coordinates before conversion and the current base 

coordinates to calibrate. Marker point calibration, using the coordinates of the points before conversion and the 

coordinates of the point after conversion to calculate. 

Base point calibration steps: 

1. Click “base point calibration” to enter the interface shown as Figure. 

2. Please input the known point coordinates (the base coordinates before conversion). There are two methods 

to input the coordinates: Click  to get the coordinate from the points library. Or input the northing, 

easting and elevation directly. Click “current base coordinates” to set the antenna parameters, please refer 

to Figure. 

  

 

3. Input the measured height and select the measurement type. 

4. Click “Calculate” to pop up the result as shown in Figure. Then click “Ok” to return to the calibrate point 

interface. 

Note: The base point calibration should be used in a fixed solution. 
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Marker point calibration steps: 

1. Click “marker point calibration” to enter the calibration point interface shown as Figure. Then input the 

known point coordinates and click  to get the current WGS84 coordinates. 

2. Click “OK” to pop up the result. Then click “OK” to return to the calibrate point interface. 

Click “view local offsets” to view the local offsets, please refer to Figure. 

 

  

Calibrate point should be done on the basis of the already open transformation parameters. Local offsets are 

commonly used in the transformation parameters switch machine operations have been carried out and the base, 

or a work area of transformation parameters, can be directly input and local offsets parameters is, in fact, the use of 

a common point calculation of two different coordinates "three parameters", referred to as the local offsets in 

software. 

The following is the case where the calibrate point is used. 

1. In the startup mode parameters of base, the “use current coordinates” is selected, and the base have 

been restarted or the position has been moved, the rover should calibrate point. 
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2. When the user knows the conversion parameter of the work area, the base could be set up at any place. 

Please input the conversion parameter, and the rover should calibrate point. 

3. In the startup mode parameters of base, the “input base coordinates” is selected, and the base has been 

moved, the rover should calibrate point. 

4. In the startup mode parameters of base, the “input base coordinates” is selected. If the base hasn’t been 

moved, it just be restarted, the rover doesn’t need to calibrate point. 

Note: The calibrate point parameters will not refresh the current point coordinates in the library. When display the 

current point coordinates, it will also display the calibrate point parameters, the subsequent measurement of the 

coordinates will be corrected by the calibrate point parameters. Transformation parameters by calculating the 

parameters of the library will refresh the current coordinates of the point. The WGS-84 coordinates of the 

measurement point are converted to local coordinates by conversion parameters. 

 

7.1.3 Change Station Coordinates 

The feature Change Station Coordinates is useful in Base-Rover RTK working mode. When you save a point with the 

rover, Cube-a also saves the coordinates of the base of the point, so, if you want to move the base to a different 

place, you can use the Change Station Coordinates to change the base coordinates, then Cube-a will calculate the 

saved points coordinates in order to keep the same baselines length. 

Warning: this feature is in BETA PREVIEW. Do not use it on real surveys to avoid any possible data loss. 

 

7.1.4 Sensor Options 

User can enable and disable the e-bubble and IMU following the configurations available on the specific receiver. 

To enable the e-bubble/ pole tilt correction feature is enough select it and confirm clicking on OK. Inside this menu 

is possible also define a maximum tilt angle to consider the pole be vertical. So, this will be the tolerance for the 

verticality of the pole during the survey. Within this limit the software will consider the pole vertical then will proceed 

eventually with the measure of the points. 

There is also the possibility to set the automatically collection of points if the pole is assumed to be in vertical 

respecting the limit set. 

It is possible shows during the survey the live tilt angle of the receiver. 

If the user prefers, there is also the opportunity to shows the animations of the initialization of the IMU sensor every 

time it goes out calibration during the survey. Once the user knows how to work with the sensor is possible disable 

them remove the check on this option. 
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7.1.5 Calibrate Sensor 

Calibrate Sensor page depends on the connected receiver. 

Stonex receivers with the new IMU technology  

Follow the shown instructions to perform the calibration. 

A Fixed GNSS solution is mandatory. 

Check the antenna height: a wrong antenna height will make the calibration not accurate.  

Wait for the message Ready To Go, start the calibration by clicking on the Start button. 

 

 

As shown in the picture below, to correctly calibrate the sensor, it’s necessary to choose an arbitrary first direction 

as a reference (direction A), then start to move the receiver back and forth along that direction and until a message 

asking to change the direction appears. 
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Rotate the receiver 90 degrees clockwise, reaching the direction A+90° = B, and continue to move back and forth 

the device. 

 

This operation must be repeated for 3 times, thus every 90 degrees up to a total of 270° clockwise.  

After moving the device back and forth along the direction D, the message Calibration Terminated will appear. 

If the calibration fails, an error message will be shown. In this case, repeat the calibration procedure. 
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Stones receiver with the old Tilt Sensor 

Click “Calibrate”-> “Calibrate sensor” to enter the page shown as Figure. There are three function keys in this 

interface, including e-bubble calibration, magnetic azimuth calibration and magnetic declination calibration. There 

are four steps to perform sensor calibration, and the operation of these four steps will be described in detail below. 

1. Enable pole-tilt correction 

Click Configure -> System settings, select “Pole – Tilt correction” in tilt survey, then click “OK”. 

2. E-bubble calibration 

①  Click “calibrate -> calibrate sensor -> ” to enter the e-bubble calibration interface shown as Figure. 

②  After the bubble centered on the retractable pole, please click the “calibrate” button. At this time, the e-

bubble in RTK and the bubble on the retractable pole are both centered, the bubble in Cube-a turns to green 

shown as Figure. 

Note: The values displayed in the bottom of the screen. 

Left——inclination angle 

Right——Azimuth 

3. Magnetic azimuth calibration 

Click “ ” to enter the interface shown as Figure. 

① Record vertical data : follow the Figures to install the calibration support pole, the limited block should be stuck 

in the groove of RTK. After you install the calibration support pole, please click “vertical”, and do circular motion 

centered on the retractable pole and the speed cannot more than 15 ° / s. The retractable pole rotated a circle, 

after finish the data record, the receiver will beep. The vertical data recording process shown as Figure. After the 

vertical data recording shown as Figure.  
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4. Record Horizontal data: Follow the Figure to install the calibration support pole. Click “horizontal”, and do 

circular motion centered on the retractable pole while keeping an angular speed lower than 15°/s. When a complete 
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rotation around then retractable pole has been completed, data recording will stop, and the program will beep. The 

horizontal data recording process shown as Figure. After the horizontal data recording shown as Figure. 

  

 

Note:  

A. When rotated, the software will display the real-time status of the current data recording. 

B. If the data of some locations is not recorded (too fast rotation will lead to data missed recorded), you need to 

rotate again to the location for the second recording. 

C. When the recording is complete, there will be a beep and "Vertical Data recording is Complete" or "Horizontal 

data recording is complete!" displayed on the screen. 

D. When recording horizontal data, the tilt angle must be less than 3 degrees. 

 

③ Calibrate parameter: After the vertical and horizontal data recording is complete, click "Calibrate", there will 

pop up the dialog box of the calculating result of the parameters, as shown in Figure. Click "OK" to use this 

calibration parameter, as shown in Figure, to complete the "calibrate sensor". 
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④.Magnetic declination calibration 

Click “ ” to enter the interface shown as Figure. 

① Record center points: click “center point” to record center points, it need to record the coordinates of 10 

static points. In the recording process and after the recording, please refer to the Figure and. 

Recording condition:  a. relative static state    b. inclination angle <0.3°           

  c. fixed solution            d. recorded 10 points  
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② Record incline points: Click “incline point” to record the incline points, it needs to be recorded in four 

directions (east, south, west and north), and should to record coordinates of 10 static points in every direction. 

In the recording process and after the recording, please refer to the Figure. 

Recording condition: 

a. relative static state  

b. inclination angle 25°-35°  

c. Fixed solution     

d. Recorded data in every direction (east、south、west、north)   

e. Recorded 10 points in every direction 

Note:  
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A. When do the magnetic incline calibration, it is recommended that the retractable pole be extended to 2 m or 

more. 

B. Keep the Device as smooth as possible when recording data. 

③ Calibrate parameter: After the center point and the incline point have finished recorded, click “calibrate” to 

calculate Magnetic declination parameters, there will pop up the dialog box of antenna parameter settings, 

shown as Figure. After you input the antenna parameter, please click “OK”, then there will pop up the prompt 

about the projection correction. Please click “OK” to finish the sensor calibration. 

④ After the sensor calibration, you can click “Settings” to view the magnetic declination. If you know the 

magnetic of the work area, you do not need to do the sensor calibration, please just input the magnetic 

declination in “settings”. 

Note: If there is a prompt that the error overrun, please check the antenna height is right or not. Then extend the 

retractable pole to redo the sensor calibration. 

 

 

7.1.6 RMS Study 

You can check the accuracy of the tilt compensation through the RMS quality check. If the accuracy (RMS) is good, 

then you can continue working. If the accuracy (RMS) is not good, then calibrate the sensor using the Calibrate 

Sensor function. The RMS Study performs the study of the quality/accuracy of repeated measures (keep the pole 

tip at the same exact position on the ground). 

How to use it? Open the Calibrate menu, then select the RMS Study command. When inside the RMS Study screen, 

click Start to collect the measures. 
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The application will collect measures/positions at an average frequency of 1Hz. Collected positions will be averaged 

and RMS values will be computed. The RMS values let the user to verify if the accuracy of the device falls within 

some required accuracy upper limit. If the RMS values are not satisfactory then the user can, and he should, proceed 

with the calibration. 

 

 

The user has the control of the number of sample positions used in the RMS calculation. When the user decides to 

complete the check, he can press Stop to stop the automatic position acquisition. 

As said, if the RMS values are not satisfactory then the user can, and he should, proceed with the sensor calibration. 

This operation is also suggested when the user changes the pole height and/or the pole type (there could be a 

change in the straightness of the pole). 

 

7.2 Total Station  

7.2.1 Station on point 

Click Calibrate-> Station on point: there will pop up the interface as shown in figure below. 

Coordinates of point station can be inserted manually, by filling in the Easting Northing and Elevation cells, or:  

• Measured by GNSS antenna (if available). Tapping on it, Cube-a will directly collect coordinates as a 

Topo Point; 

• Selected from the map, including CAD entities; 

• Selected from the point list. 

If you want to change the point name, edit the cell on the left.  

Insert the Instrument height (total station height). 
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As an alternative to inserting the elevation, it is possible to use the observation of a reference point. Define the 

reference point in the same way as you did for the station point and insert its target height; then, observe it. Click 

on Next.  

 

In the next page, define which orientation mode you want to use:  

• To known point: it orients the station on a point whose coordinates are known. Insert coordinates of a 

point or measure it or select it from the project (in the same way as you did for the station point and 

define the target height;  

• By azimuth: it orients the station to a direction. Insert the reference angle with respect to the North of 

the local system (not to be confused with the horizontal/azimuth angle read by instrument); 

• None: it does not care the orientation. As default, Cube-a will use default horizontal angle of the total 

station.  
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If you have selected None, you can directlty Activate the station, otherwise you have to Measure the orientation 

point: 

• HA Zero Set: it sets the horizontal angle of the instrument to zero; 

• HA Set: it allows to enter the desired horizontal angle; 

• Measure HA: it shows the horizontal angle measured by the instrument; 

• Measure FULL: it measures the distances of the orientation point. 

Click on OK, once measured.  
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At the end of the procedure, Cube-a will ask you if you want to proceed enabling the station on the defined point. 

Click on Yes to proceed.  

 

 

7.2.2 Resection/Free Station 

Click Calibrate-> Resection/Free Station: there will pop up the interface as shown in figure below.  

Insert the Station point name and the Instrument height.  

Choose to tick or not “Adjust the ground to grid scale factor”. Enabling it, all the measures made with the total station 

will be scaled by using the scale factor of the Reference system you have defined in the project. If you are only 

working with total station in a local reference system, it is advisable to do not tick the setting, to have real distances, 

without corrections applied.  
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You can select an Existing free station or Import/Export a calculation.  

Click on Next to insert and measure the points for the calculation. Cube-a asks you to satisfy one of the following 

requirements:  

• 3 or more angular readings. 

• 2 or more full readings (angles + distance); 

• 2 or more mixed readings (angles + distance/ only angles). 

Click on Add to insert the first point. 

 

Coordinates of point can be inserted manually, by filling in the Easting Northing and Elevation cells, or:  

• Measured by GNSS antenna (if available). Tapping on it, Cube-a will directly collect coordinates ad a 

Topo Point; 

• Selected from the map, including CAD entities; 

• Selected from the point list. 

If you want to change the point name, edit the cell on the left.  
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Insert the Target height and click on Measure.  

 

Aim the point and proceed with the measure, which can be: 

• Measure HA: only angle measure; 

• Measure FULL: angles and distance.  

Proceed pressing OK.  

 

The first point observation will be listed in the following page.  
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Continue adding the next point(s), proceeding in the same way as before.  

You can see the results of the calculations:  

• Calculated E, N, Z coordinates of the station; 

• Station E, N, Z standard deviations, which defines the estimated possible error of the coordinates. They 

can be positive or negative values; 

• Planimetric and Vertical coordinates residuals (Measured- Known). They are absolute - in metres declared 

values. 

dH is the difference between the calculated and the known point in 2D 

dV is the difference in altitude between the calculated and the known point. 

• Scale factor is reported 

• Circle to azimuth correction is the horizontal angle correction which the free station program calculates 

with respect the horizontal circle of the total station.  

 

If needed, you can tap on and  to deactivate the Horizontal and/or Vertical angular reading and check if 

the results quality increases. The same command is performed by the H and V on the blue icons.  

You can click on Edit to modify a point or re-perform its measure. Or you can click on Delete to remove a point. 

Before confirming with OK, you can tap on Previous to go back to the where it is possible to export the free 

station calculation.  



 

 

          Stonex Cube-a 5.x – User Manual   104 

 

A free station file can be exported with *.cr extension: 
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8. Tools 
 

Click “Tools” as shown in Figure. It consists of 10 submenus, namely Points Library, Entity List, Coordinates Converter, 

Angle Converter, Perimeter, and area, COGO Calculation, Calculator, Version and Update, WMS Servers, Rescan 

Folders 

 

 

8.1 Point Library 

Click “Tools”-” Point Library”. 
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Points library is for unified management on all kinds of coordinates. It adds point coordinates used in operation, 

helping invoke them in point setting-out. It supports quick search on coordinate points through entering point 

name or point No. in the Search box. Points Library consists of 8 contents, namely Add, Edit, Details, Delete, OK, 

Import, Options and Close. 

Click “Add” as shown in Figure. Coordinates type includes Local Coordinate and Geodetic Coordinate. Property 

type includes Assistant point, Control point, Input point and Stakeout point. Input point name, plane coordinates 

(x, y, h) or latitude/longitude coordinates and Code after setting up Coordinate type and Property type to 

accomplish parameter set up of new coordinates. 

Choose any points in the Points Library. And click “Edit” to edit the Point name, plane coordinates (x, y, h) or 

latitude/longitude coordinates and Code, which applies to all points but Survey points. Click “Details” to check 

the Point name, Code, latitude/longitude coordinates, plane coordinates (x, y, h) and Type. Click “Delete” to 

delete the chosen point from the Points Library. 

Click “Import” and choose file format to import coordinates file, helping search and invoke coordinates in point 

setting-out. It supports Measurement data file(*.PD) and Custom format file(*.cvs, *.dat and *.txt). 

Click “Option” as shown in Figure. Tick the point types to present as needed to filter other unwanted point types. 

It includes 7 options, namely Auxiliary Point, Survey Point, Control Point, Input Point, Calculate Point, Stake Point 

and Screen Point. 

 

8.2 Entity List 

The Entity list includes the list of all enity inside the project exept the points. So, it includes polylines, parcels and 

other entities created. 

Also, for the entities there is the opportunity to edit or delete them. 
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To edit an entity is necessary select it and press edit 

 

If the entity has GIS data is possible modify them after the closing of the item. 

 

8.3 Coordinate Converter 

Click “Tools”- “Coordinate Converter” as shown in Figure. Choose Conversion Mode, input coordinates, and click 

“Calculate” to accomplish coordinate conversion and check result as shown in Figure. If it needs to save the 

converted coordinates, click “OK” and input the point name to save it to the coordinate library. 

There are two Conversion Modes: “From WGS84 coordinates to current local coordinates”, and “From current local 

coordinates to WGS84 coordinates”. 

There are two ways to set up the converting coordinates: one is directly inputting the Latitude, Longitude and 

Altitude or plane coordinates (x, y, h); the other is extracting points from Points Library. 
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8.4 Angle Converter 

Click “Tools”- “Angle Converter” as shown in Figure. It includes 6 angle formats, namely dd.mmssss, dd:mm:ss, 

dd°mm'ss, dd(Decimal), SS and Radian. 

The conversion goes in the following sequences:1. choose input angle format; 2. input angle; 3. choose angle 

converted format; 4. angle conversion accomplished, converted result presented in the angle box. 

For instance, input angle 23.25, convert it into dd(Decimal), and the result is as shown as in Figure.     

  

 

8.5 Perimeter and area 

Click “Tools”- “Perimeter and area” as shown in Figure.  
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Click “Add” to set up at least 3 coordinates. You can enter the coordinates filling in the cells, or  select a point 

from the map, or  measure the point or  select the point from the list.  

 

Otherwise, click “Import” to choose import coordinates file (*.dat and *.txt). The imported data can be filtered 

(through PointName or Code), searched and selected to determine the points used for Perimeter and Area 

calculation.  
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Points can be chosen to “Edit” and “Delete” or modify their order using “Move up” and “Move down”. 

Click “Calculate” to check the result, i.e., the Area and Perimeter of the graph composed by the set-up points as 

shown in Figure.  

 

 

8.6 COGO Calculation 

Click “Tools”- “COGO Calculation” as shown in Figure. According to the known coordinates, it can Figure out position 

relations between point and point as well as between point and line. It includes Azimuth and Range, Angle offset, 

Distance, Two Lines Angle, 2 alignments intersection, Hidden point Two Points Two distances, Two Points Two 

Angles, Two Points distances plus Angle, Polar from North, create random points and point averaging. 
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8.6.1 Azimuth and Range 

Click “Tools”- “COGO Calculation”- “Azimuth and Range” as shown in Figure. Set Start Point and End Point and click 

“Calculate” to check the result of Plane distance, Azimuth, Elevation difference, Ratio of slope and Vector, as shown 

in Figure. There are three ways to set points: 1. extract coordinates from Points Library; 2. acquire current GPS 

coordinates; 3. directly input values of Northing, Easting and Elevation. 

  

 

8.6.2 Angle offset 

Click “Tools”- “COGO Calculation”- “Angle offset” as shown in Figure. Set Start Point, End Point and Offset Point, 

and then click “Calculate” to check the result of Start distance, End distance, Start Vertical Distance, End Vertical 

Distance, Offset Distance and Offset Angle as shown in Figure. 
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8.6.3 Distance 

Click “Tools”- “COGO Calculation”- “Distance” as shown in Figure. Set Start Point and End Point, and then click 

“Calculate” to check the result as shown in Figure. 

  

 

8.6.4 Two Lines Angle 

Click “Tools”- “COGO Calculation”- “Two Lines Angle” as shown in Figure. Set Start Point A, End Point B, Start Point 

C and End Point D, and then click “Calculate” to check the result as shown in Figure. 



 

 

          Stonex Cube-a 5.x – User Manual   113 

  

 

8.6.5 2 Alignments Interception 

Click “Tools”- “COGO Calculation”- “2 Alignments Interception” as shown in Figure. Set Point A, Point B, Point C and 

Point D, and then click “Calculate” to obtain the point coordinates in chart as shown in Figure. If it needs to save the 

calculated point, click “OK” to save it to the coordinate library. 

 

 

8.6.6 Hidden Point - Two Points Two Distances 

Click “Tools”- “COGO Calculation”- “Hidden Point - Two Points Two Distances” as shown in Figure. Measure 

distances 1 and 2, Point A and Point B, and then click “Calculate” to obtain the point coordinates in chart as shown 

in Figure. If it needs to save the calculated point, click “OK” to save it to the coordinate library. 

As default the software calcules the point at the left of Point A and Point B used for the calculi. There is the possibility 

the point at the right selecting the check before to start the calculi. 
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8.6.7 Hidden Point Ang + Ang 

Click “Tools”- “COGO Calculation”- “Hidden Point Ang +Ang” as shown in Figure. Set Angle α, β, Point A and Point 

B, and then click “Calculate” to obtain the point coordinates in chart as shown in Figure. If it needs to save the 

calculated point, click “OK” to save it to the coordinate library. 

 

 

8.6.8 Point by Polar (from Direction) 

Click “Tools”- “COGO Calculation”- “Point by Polar (from Direction)” as shown in Figure. Set Line L1, Angle α, Point 

A and Point B, and then click “Calculate” to obtain the point coordinates in chart as shown in Figure. If it needs to 

save the calculated point, click “OK” to save it to the coordinate library. 
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8.6.9 Point by Polar (from North) 

Click “Tools”- “COGO Calculation”- “Point by Polar (from North)” as shown in Figure. Set Line L1, Angle α and Point 

A, and then click “Calculate” to obtain the point coordinates in chart as shown in Figure. If it needs to save the 

calculated point, click “OK” to save it to the coordinate library. 

 

    

8.6.10 Create random points 

This feature creates points random following the set rules. 

User must set the name of the points and the number, then the symbol. 
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Select the mode and the limit of the area where he wants to create the points and the respective limits before to 

start the calculation. 

 

 

8.6.11 Point averaging 

You can check the operation and the accuracy of the GNSS through the RMS quality check. The RMS Study performs 

the study of the quality/accuracy of repeated measures (keep the pole tip at the same exact position on the ground). 

How to use it? Open the Calibrate menu, then select the RMS Study command. When inside the RMS Study screen, 

click Start to collect the measures. 

The application will collect measures/positions at an average frequency of 1Hz. Collected positions will be averaged 

and RMS values will be computed. The RMS values let the user to verify if the accuracy of the device falls within 

some required accuracy upper limit.  
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The user has the control of the number of sample positions used in the RMS calculation. When the user decides to 

complete the check, he can press Stop to block the automatic position acquisition. 

This operation is also suggested when the user changes the pole height and/or the pole type (there could be a 

change in the straightness of the pole). 

 

8.7 Calculator 

This functionality directly invokes the calculator in handheld system, helping on data calculation. 

 

 

8.8 Version and Updates 

Click “Tools”- “Version and Update” to see the following figure:  
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It contains:  

1) Current version installed on the device 

2) Check for updates; tapping on it, a check is made to see if there is a new version of the software compared to 

the one currently installed. If a new version is available, a popup will suggest you download and install the latest 

version 

3) Update info: tapping on it, you will have the historian of the “Bug fix”/"What's new" of the latest versions 

4) Activation info: it enters the page where you can manage your license 

 

1) Deactivate all: tapping on it, all the codes will be cancelled. Note: if you have a working code, copy it or 

you will lose it.  

2) Main purchase code/activation: it shows, or you have to insert, the purchase code. 

3) Active modules 

4) Activate/Deactivate: to activate the main purchase code or deactivate it (if already active) 

5) Optional purchase code/activation: to insert an optional code. 

6) Activate/Deactivate: to activate the optional purchase code or deactivate it (if already active) 

7) Export: it allows to export the code in a *.txt file. 

 

8.9 WMS Servers 

The WMS Servers feature will be officially available in Q1 2021. 

 

8.10 Folder Rescan 

Click “Tools”- “Rescan Folders” to see update the folders of your projects and see the following figure: 
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Choose to:  

• Scan current project folders 

• Scan all project folders 

• Scan all application folders 

And click on Start.   

 
STONEX® SRL 
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